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Introduction
The Report Scheduler module enables flexible, secure scheduling and publishing of 
your Report Writer reports. Report Scheduler is installed automatically when you 
install Microsoft Dynamics GP. Report Scheduler is simple to set up and use, and 
requires little maintenance.

This introduction is divided into the following sections:

• What's in this manual
• Symbols and conventions
• Resources available from the Help menu

What's in this manual

This manual is designed to give you an in-depth understanding of how to use 
Report Scheduler to publish any report or report option you have available in 
Report Writer.

Some features described in this documentation are optional and can be purchased 
through your Microsoft Business Solutions partner. 

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP...

This manual contains the following chapters:

• Chapter 1, “Report Scheduler Setup,” describes how to set up Report Scheduler 
and change report names.

• Chapter 2, “Scheduling Reports,” describes how to schedule reports with 
Report Scheduler.

• Chapter 3, “Publishing Reports,” describes how to publish reports with Report 
Scheduler.

• Chapter 4, “Report Catalog Maintenance,” describes how to maintain published 
reports in the Report Catalog Maintenance window.
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Symbols and conventions

This manual uses the following symbols to make specific types of information stand 
out.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be especially 
aware of when completing tasks. Typically, this includes cautions 
about performing steps in their proper order, or important reminders 
about how other information in Microsoft Dynamics GP might be 
affected.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print The (>>) symbol indicates a sequence of actions, such as choosing 
items from a menu or a toolbar or pressing buttons in a window. This 
example directs you to go to the File menu and choose Print.

TAB or ENTER Small capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent revisions 
of upgrade and implementation documentation, plus documentation for 
service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-to 
articles, and white papers for users.

Developer documentation and resources The most recent documentation and 
updated information for developers.

Product support information Information about the Microsoft Dynamics GP 
product support plans and options that are available, along with information 
about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you can 
ask questions or share your expertise with other Microsoft Dynamics GP users.

CustomerSource home page A wide range of resources available to customers 
who are registered for a paid support plan. Includes access to Knowledge Base 
articles, software downloads, self-support, and much more.
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Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Report Scheduler Setup
Report Scheduler works with Microsoft Dynamics GP report options and reports 
that have been created using Report Writer. Report Scheduler is installed 
automatically with Microsoft Dynamics GP. This section contains information on 
how to set up Report Scheduler and change report names.

This information is divided into the following sections:

• Setting up Report Scheduler
• Selecting a publish location
• Changing report names

Setting up Report Scheduler

Report Scheduler setup involves defining the default publish location, the value for 
the Next Report File Name field, and the export file type for reports. Use the Report 
Scheduler Setup window to define these default settings for published reports.

To set up Report Scheduler:
1. Open the Report Scheduler Setup window. 

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Setup)

2. Enter the Universal Naming Convention (UNC) path for the default location to 
publish reports to. You can either type the UNC path or select the folder icon in 
the Default Location field to open the Select Pathname window where you can 
select the default location for published reports. See Selecting a publish location 
on page 6 for more information. Be sure that all users who will be publishing 
reports have write access to the folder you select.

3. Enter the next report file name. This file name should allow for incrementing 
because the Next Report Name field will be incremented every time a report 
option is published that needs a report file name.

The name in this field is used for reports that do not have a file name stored as 
part of the report option. This file name will also be used if you choose to keep 
prior versions of a published report.

When you define the next report file name, you determine the number of report file 
names that will be available. For example, if you enter BDR001 in the Next Report File 
Name field, only 999 unique report file names will be available. 
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4. Select a file type for report output files.

The Adobe Acrobat PDF option is available if you have Acrobat Distiller or PDFWriter 
installed. These items can be purchased from Adobe Systems. You can set the export file 
type to Adobe Acrobat PDF, even if there are some workstations that do not have 
Acrobat Distiller or PDFWriter installed. If the report is not set to print to a file, and 
the default export file type is set to Adobe PDF, workstations that don’t have Acrobat 
Distiller or PDFWriter installed will publish the report as a text file.

5. Choose Save to save your selections and close the Report Scheduler Setup 
window.

Selecting a publish location

Because it is possible for users to map different drive letters to the same location, a 
Universal Naming Convention (UNC) path is required. A UNC path provides a 
common method for accessing files on a network without using a “mapped” drive 
letter. The UNC format is //server/shared folder/. Server is the name of the 
network machine where the files reside. Shared folder is the shared folder where the 
files reside and are published. There must be two forward slashes before the 
machine name (//) followed by the shared folder and a final forward slash (/).

You can type the location directly into the Report Scheduler Setup window or you 
can use the following steps to select a path in the Select Pathname window:

Before you select the location, you may wish to create a new Report Scheduler folder on the 
server where you will be saving reports.

To select a publish location:
1. To set the default publish location for all reports, open the Report Scheduler 

Setup window.
(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Setup)

To set a publish location for selected reports, open the Report Schedule window.
(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Schedule)

2. Choose the folder icon. The Select Pathname window opens.

ServerDomain Folder
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3. Select My Network Places from the Save in list.

This path must be selected from My Network Places in order for the share to take effect, 
even if it is local.

4. Select the domain where the server is located.

5. Select the server you will be saving reports to.

6. Select the folder to store reports in and choose Save.

Changing report names

It is important to be able to change report names in Report Scheduler because 
several reports in Microsoft Dynamics GP have the same name. For example, an 
Aged Trial Balance report appears in both Receivables Management and Payables 
Management. To distinguish between these reports more easily, you can change the 
report names to Receivables Aged Trial Balance and Payables Aged Trial Balance. 
Use the following steps to change a report name:

To change report names:
1. Open the Report Names window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Names)

2. Click in the Report Name column next to the report to modify. Remember that 
many reports have the same name. Check the location of the report in the 
Report Navigation column to ensure you are modifying the report from the 
correct module.

3. Type the new name of the report. This must be a unique name. The default 
value in the Report Name column is the original name of the report. You can 
change it to another name, as long as that name doesn't already exist. A blank 
name is not allowed.

4. Close the Report Names window to save report name changes.
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Chapter 2: Scheduling Reports
After you set up Report Scheduler, you can schedule reports. Scheduling reports 
includes defining the publish frequency and location.

This information is divided into the following sections:

• Scheduling a report
• Report options
• Frequency examples

Scheduling a report

Use the Report Schedule window to define the publish location and frequency for 
each report to publish. If you have Business Portal, you also can assign reports to 
Business Portal center pages and roles.

To schedule a report:
1. Open the Report Schedule window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Schedule)

2. Mark the box next to the report(s) to schedule in the scrolling window.

3. Select the frequency option indicating how often to publish the marked reports 
then set the scheduling options. Scheduling options in the Report Schedule 
window change based on the frequency option you select. See online help for 
descriptions of each frequency option. See Frequency examples on page 11 for 
more information.

4. Enter the start date. This field controls when a report is first scheduled to be 
published.
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5. Choose Calculate Next Date to verify that the report will publish on the desired 
date.

6. Select the versions of the report to keep. Select Current Only to remove prior 
versions of the report output when a new report is published. Select Current & 
Prior to save the report with the value in the Next Report File Name field in the 
Report Scheduler Setup window the next time a report is published.

7. To change the publish location for the marked report(s), select a new location. 
See Selecting a publish location on page 6 for more information. Be sure all users 
who will publish the report(s) have write access to the folder you select. 

8. To view details for a specific report, select the report in the scrolling window, 
then choose the expansion button next to the Report Name column heading. 
The Report Schedule Details window opens where you can view or modify the 
settings for Versions of Report To Keep, Publish To Location, and Frequency. 
You also can view information about publishers for the report.

9. To change the Report Option settings for a specific report, select the report in 
the scrolling window, then choose the Report Option link. See Report options on 
page 10 for more information. 

10. If you have Business Portal, mark the Business Portal center pages and roles to 
assign to the marked reports.

11. Choose Publish Now to publish the marked reports now or choose Apply to 
apply the settings to the marked reports and wait until the scheduled publish 
date. See Automatic publishing on page 13 for more information. The settings you 
choose in the Report Schedule window will affect the marked reports once you 
choose Apply.

When you choose either Apply or Publish Now, you will be added as a publisher for the 
marked reports.

Report options

Microsoft Dynamics GP report options provide the ability to save criteria about a 
report, such as range restrictions, sorting options, and destinations. These report 
options can be used to generate separate versions of a report. See Microsoft 
Dynamics GP help for information on creating and using report options.

Since Report Scheduler works with Microsoft Dynamics GP report options, you 
need to take into account the restrictions, or lack thereof, a report option has when 
you are publishing it. For reports created with Report Writer, you save criteria about 
a report using the Restrictions window in Report Writer.

If the people who will have access to the report output should see only certain 
ranges of the data, then you should create a report option for each grouping, with 
the appropriate restrictions for each group. For example, you could create a single 
sales commission report for all salespeople and use report options to publish 
separate reports for each salesperson.

Microsoft Dynamics GP limits the number of report options available for each report to 32.
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Frequency examples

This section contains examples of setting daily, weekly, and monthly frequency. 
These examples show how frequency options and start dates affect the publish date. 
Use this information as a reference to help you select frequency settings for your 
report.

Frequency example - Daily
If you use September 6, 2008, as the start date and choose the Daily frequency 
option combined with the Every Day scheduling option, the selected reports will 
print every day from September 6, 2008, onwards.

If you combine the Daily option with the Weekdays option, the report would be 
scheduled to print Monday through Friday with September 8, 2008, being the first 
scheduled date. Because it is on a weekend, September 6, 2008, is not included as a 
scheduled date.

If a report was last published on September 5, 2008, with a Daily frequency option 
and an increment of 5 in the Every ? days field, the next scheduled publishing date 
would be September 10, 2008. If, however, someone were to publish the report 
manually on September 7, 2008, the next due date would be September 12, 2008.

You can use a number between 1 and 999 in the Every ? days field.

Frequency example - Weekly
Selecting the Weekly frequency option combined with the Day Of The Week 
scheduling option makes the check boxes for each week day visible. You must mark 
at least one of these boxes.

If you mark Monday and Wednesday, the report will be published the next Monday 
or Wednesday, which ever comes first. If the report option is scheduled to publish 
on Mondays and Wednesdays, and for some reason it is not published on Monday, 
when you log on to Microsoft Dynamics GP on Tuesday, this report option would be 
listed as overdue. If you don’t log on to Microsoft Dynamics GP on Tuesday, and 
instead log on to Microsoft Dynamics GP on Wednesday, the report option will be 
published then, but only once. The Monday publishing is skipped.
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You also can specify the number of weeks between publishing. For example, if the 
report was last published on September 6, 2008, and it is set to publish every 2 
weeks, the next time it will be due to be published is September 20, 2008. 

Frequency example - Monthly
When you select the Monthly frequency option, you also can specify the day, week, 
and month(s) to publish a report. As a result, you can define a report option to be 
published the first Monday of each month, regardless of the number day this 
happened to be. If a report option is set up to publish on the first Monday of the 
month in March, June, September, and December, and it is published manually on 
August 25, 2008, it will be due for publishing on September 1, 2008.

If a report option is scheduled to be published on the 15th day of the month in 
March, June, September, and December, and it is published manually on September 
1, 2008, it will be due for publishing on September 15, 2008.

You can select any value between 1 and 31 in the Day option when the Frequency is set to 
Monthly. If you enter day 31 and the month you selected does not have 31 days, the report 
will be scheduled for the last day of that month.
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Chapter 3: Publishing Reports
Publishing involves creating an output file for a report. Publishing can be done 
either manually from the Report Schedule window or automatically when users log 
on to Microsoft Dynamics GP. Before automatic publishing can occur, you will need 
to set up publishers for the reports.

Information on publishing reports is divided into the following sections:

• Automatic publishing
• Manual publishing
• Setting up report publishers
• Troubleshooting publishing

Automatic publishing

When you log on to Microsoft Dynamics GP, Report Scheduler views the 
information in the Report Publishers window to determine the reports you have 
been set up to publish. If it finds any reports that are either due that day, or are past 
due, it displays the Report Scheduler Overdue Reports Message window. 

Choose Yes to publish the reports in the background. If you choose No, the reports 
remain overdue and the message will reappear next time you log on to Microsoft 
Dynamics GP. If you unmark Ask Each Time, any reports that are due or overdue 
will be published automatically the next time you log on to Microsoft Dynamics GP. 
If you later decide that you don’t want reports to be published automatically, open 
the Report Publishers window, enter your user ID, then mark Ask Each Time.

Choose Details to open the Report Schedule window where all reports that are due 
or overdue will be marked. If the list is correct, choose Publish Now to publish the 
reports. You also can mark additional reports, unmark reports, or make any other 
changes in the window before you publish the reports.

The following information also applies to automatic publishing:

• Because some computers may never be logged off, a check will be made at 00:01 
every 24 hours. If the computer is still logged on at that time, any reports due 
that day will be published automatically.

• If more than one user is set up to publish a report, the first user to log on will be 
the one to publish the report. Any other users set up to publish the report will 
not trigger the report to be published because it no longer has an overdue 
publishing status.



C H A P T E R  3    P U B L I S H I N G  R E P O R T S  

14 R E P O R T  S C H E D U L E R

Manual publishing

To publish a report at any time, choose Microsoft Dynamics GP menu >> Tools >> 
Routines >> Company >> Report Schedule, mark the reports to publish and choose 
Publish Now. When you choose Publish Now, you will be added as a publisher for 
the marked reports. After the reports have been published, the last published date 
and location information for those reports will be updated and all reports will be 
unmarked.

Setting up report publishers

You can define multiple users to publish a report so that if a user is unavailable 
when the report needs to be published, another user could publish it. It is also a 
secure way of ensuring users see only those reports they are entitled to view.

To set up report publishers:
1. Open the Report Publishers window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Publishers)

2. Enter or select a user. The scrolling window displays all reports that have a 
publish frequency other than Not Scheduled, as defined in the Report Schedule 
window. If the user you selected has already been set up as a publisher, the 
scrolling window will display all current settings. 

3. Unmark Ask Each Time if you want overdue scheduled reports to print 
automatically when the selected user logs on to Microsoft Dynamics GP.

4. In the Publish column, mark the reports the user will publish, or choose Mark 
All to mark all reports.

5. To view the report option settings for a given report, select the report, then 
choose the Report Option link.

6. To view details for a specific report, select a report, then choose the expansion 
button in the top right of the scrolling window. The Report Schedule Details 
window opens where you can view or modify report settings.
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7. Choose Save to keep all changes made in the Report Publishers window or 
choose Delete to remove all reports from the user’s publish list. If you close the 
window without choosing Save, any selections you have made since you 
opened the window will be retained. This occurs because information about 
publishers is saved each time you mark or unmark a report.

Troubleshooting publishing

Report Scheduler displays a message if there are errors during publishing.

Choose Yes to view the error log or choose No to close the window. If an error 
message appears when a report is published, check the following items:

• Because Report Scheduler supports the printing of custom reports, each user 
needs the necessary report dictionaries for publishing to occur. If the report to 
be published does not exist in the report dictionary on the workstation 
publishing the reports, or if the publisher does not have the product installed, 
an error log will be created. The Last Published date on the Report Schedule 
window will not be updated.

• If the publisher does not have access to the default location for the selected 
reports due to such issues as network permissions, an error will be written to 
the Error Log table.

• If the publisher does not have access to print all the reports a report option 
prints, an error log will be written and the report will not be published. The 
Report Catalog Maintenance window will not be updated.
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Chapter 4: Report Catalog Maintenance
Information about published reports is recorded in the Report Catalog. It is 
important to manage reports to ensure unwanted information is not using memory 
unnecessarily. This is particularly important if you selected to keep current and 
prior versions of a report in the Report Schedule window. 

Report catalog maintenance information is divided into the following sections:

• Viewing published reports
• Deleting report catalog information

Viewing published reports

Use the Report Catalog Maintenance window (Microsoft Dynamics GP menu >> 
Tools >> Routines >> Company >> Report Catalog Maintenance) to view 
information about records in the Report Catalog table relating to published reports. 
To open the output file for a report, select the report and choose the expansion 
button in the upper right corner of the scrolling window.

Deleting report catalog information

You can use the Report Catalog Maintenance window to delete entries from the 
Report Catalog. When you delete an entry from the catalog, you also delete the 
output file for the report. The Publish To Location column in the Report Schedule 
window displays the location of the output files.

To delete report catalog information:
1. Open the Report Catalog Maintenance window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Report 
Catalog Maintenance)

2. Mark the reports to remove, choose Delete, then choose Yes if you wish to delete 
the output files associated with the marked reports. 

If any of the marked reports has a publish frequency other than Not Scheduled, 
you will be asked if you want to remove the schedule for each of those reports. 



C H A P T E R  4    R E P O R T  C A T A L O G  M A I N T E N A N C E  

18 R E P O R T  S C H E D U L E R

Choose Yes to set the publish frequency to Not Scheduled and clear the last 
published date, publish location, and list of publishers. Choose No to leave the 
report schedule information unchanged.
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Glossary
Default location

The folder you wish to publish reports to. 
This requires a Universal Naming 
Convention (UNC) path. It must start with 
the name of the computer and must be 
published to a folder you have write access 
to.

Domain
A group of computers that are part of a 
network and share a common directory 
database. A domain is organized in levels 
and is administered as a unit with common 
rules and procedures.

Export file type
The file type for the report output file. A 
report can be published as a text file, tab-
delimited, Comma-delimited, or Html file. If 
your workstation has Acrobat Distiller or 
Adobe PDFWriter installed, the option to 
publish an Adobe Acrobat PDF file is also 
available. You’ll need to specify the export 
file type when a report option does not have 
a File Format selected in the Microsoft 
Dynamics GP Report Destination window. 
The default setting is Text file.

HTML
HyperText Markup Language. Report Writer 
reports can be exported to HTML files.

Next report file name
The name that will be used when a report is 
published. The name should allow for 
incrementing as it will be used each time a 
report is published that requires a report file 
name. This file name is used for report 
options that do not have a file name stored in 
the Report Destination window. This file 
name is also used if you choose to keep prior 
versions of a published report.

PDF
Portable Document Format. Report Writer 
reports can be exported as an Adobe PDF file 
if the workstation has Acrobat Distiller or 
Adobe PDFWriter installed.

Publish
To create an output file for a report.

Publish frequency
How often a report is published. Reports can 
be published daily, weekly or monthly. 
Additional options are also available 
depending on the frequency selected. For 
example, a report published daily can be 
published every day, weekdays or every 
specified number of days.

Range
A method of choosing a data set based on a 
given field, where a starting and finishing 
record are selected. Where no range is 
selected, all data will be returned.

Report Catalog
A table that contains information about 
published reports. You can view the report 
catalog with the Report Catalog 
Maintenance window. You can use this 
window to manage information created 
when reports are published. Deleting an 
entry from this window will delete both the 
catalog entry and its associated output file.

Report name
The name of the report. The default name of 
each report on the Report Schedule window 
is the name Microsoft Dynamics GP 
provides. It can be changed on the Report 
Names window.

Report navigation
The path indicating the origin of the report. 
The report navigation is important because 
many reports have similar names, even 
within the same module.

Report options
A collection of entries that specify the 
amount of information or the type of 
information that will appear on a report. For 
example, a report can have such information 
as sorting, range restrictions and printing 
options saved for a report. Multiple report 
options can be created.

Report publishers
A user or users that have been set up to 
publish reports in the Report Publishers 
window.

Report Schedule
Settings that specify when and where a 
report is published.

Series
A group of Microsoft Dynamics GP modules 
that form an interrelated set of applications. 
A report option will be associated with a 
particular series. For example, the 
Salesperson report is in the Sales series. This 
can be found on the Report Schedule 
window.

Sorting
A method of arranging data based on the 
order of specified information.

Start date
A setting that controls the date the report 
option will be first published. The frequency 
options are all driven by the start date.

UNC
Universal Naming Convention. A common 
method for accessing files on a network 
drive without using a mapped drive letter. 
They typically appear as 
//server/volume/shared folder/.

User ID
The unique name given to each user in 
Microsoft Dynamics GP.



20 R E P O R T  S C H E D U L E R



R E P O R T  S C H E D U L E R 21

Index
B
Business Portal

center pages 10
roles 10

C
Calculate Next Date field 9
changes since last release, information 

about 3
current upgrade information, accessing on 

the Web 3

D
documentation, symbols and conventions 

2

E
errors, during publishing 15
Export File Type field 6

F
frequency

examples
daily 11
monthly 12
weekly 11

options 9
selecting 9

H
help, displaying 2
Help menu, described 2

I
icons, used in manual 2

L
lessons, accessing 3
lookup window, displaying 3

N
navigation, symbols used for 2
new features, information about 3
Next Report File Name field 5

O
Orientation training, accessing 3
overdue reports message 13

P
publishers

adding 10, 14
multiple 13
setup 14
viewing 14

publishing
automatic 13
defined 13
error log 15
frequency examples 11-12

publishing (continued)
location 6
manual 14
report publishers 14
troubleshooting 15

R
report catalog

defined 17
deleting entries 17
opening reports 17
viewing reports 17

Report Catalog Maintenance window, 
displaying 17

Report Names window, displaying 7
report options

changing 10
defined 10
limit 10
viewing 14

report publishers, see publishers
Report Publishers window, displaying 14
Report Schedule Details window, 

displaying 10
Report Schedule window, displaying 9
Report Scheduler

install 5
setup 5-6

Report Scheduler Overdue Reports 
message 13

Report Scheduler Setup window, 
displaying 5

Report Writer
reports 10
restrictions 10

reports
automatic publishing 13
changing names 7
deleting 17
export file type 6
frequency options 9
limiting access 10
manual publishing 14
multiple publishers 13
overdue 13
publish location 6-7
publisher setup 14
scheduling 9-12
scheduling options 9
security 10
setup 5-6
viewing details 10

required fields, described 3
resources, documentation 2

S
scheduling options, selecting 9
scheduling reports

Business Portal options 10
calculate next date 9
frequency 9

scheduling reports (continued)
frequency examples 11-12
frequency options 9
publish location 10
report options 10
scheduling options 9
start date 9
versions of report to keep 10

Select Pathname window, displaying 6
setup

report publishers 14
Report Scheduler 5-6

Start Date field 9
symbols, used in manual 2

T
troubleshooting 15
tutorial, accessing 3

U
UNC path

described 6
entering 5, 6
selecting 6

upgrade information, accessing on the 
Web 3

V
Versions Of Report To Keep field 10

W
what’s new, accessing 3



22 R E P O R T  S C H E D U L E R


	Copyright 
	Contents 
	Introduction 
	What's in this manual 
	Symbols and conventions 
	Resources available from the Help menu 
	Send us your documentation comments 

	Chapter 1: Report Scheduler Setup 
	Setting up Report Scheduler 
	Selecting a publish location 
	Changing report names 

	Chapter 2: Scheduling Reports 
	Scheduling a report 
	Report options 
	Frequency examples 

	Chapter 3: Publishing Reports 
	Automatic publishing 
	Manual publishing 
	Setting up report publishers 
	Troubleshooting publishing 

	Chapter 4: Report Catalog Maintenance 
	Viewing published reports 
	Deleting report catalog information 

	Glossary 
	Index 
	B 
	C 
	D 
	E 
	F 
	H 
	I 
	L 
	N 
	O 
	P 
	R 
	S 
	T 
	U 
	V 
	W 


